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Welcome 
Microsoft Dynamics™ Retail Management System Store Operations includes all 

the tools you need to accomplish your retail point-of-sale and back-office tasks. It 

consists of three components: 

 Store Operations Administrator is a program for creating and connecting to 

the store database, configuring registers, and doing database administrative 

tasks, such as creating backups and running database queries. 

 Store Operations Manager is a convenient and central location for managing 

your inventory, employees, and store information. Use it to generate reports 

and purchase orders, receive inventory, and reconcile physical inventory 

counts. 

 Store Operations POS is the point-of-sale screen cashiers use to process 

transactions and returns, look up items and customers, add new items and 

customers, and do other daily point-of-sale tasks. 

When you install Store Operations, all three components are installed. 

What’s new 

SQL Server Express is included 

Microsoft SQL Server 2005 Express Edition (SQL Server Express) is included on your 

Store Operations CD. The maximum database size has been increased to 4 GB, the 

workload governor that was present in SQL Server 2000 Desktop Edition (MSDE 

2000) has been removed, and overall server performance has been enhanced. 

Improved matrix item support 

Create and manage matrix items with ease. Use dimension sets to quickly load 

frequently used dimensions, such as sizes and colors. 

More discount options 

Both Mix and Match and Buy X, Get Y for Z discounts are now available on either 

a unit price or percentage discount basis. 

No more copy protection devices (dongles) 

Use an Internet connection or the telephone to activate the software. 
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Address verification system 

Cashiers can now record customer address information when manually entering 

credit card data. This could reduce the fees charged by the acquiring bank. 

Search by supplier 

Locate items and add them to purchase orders using supplier reorder numbers. 

Export purchase orders and inventory transfers 

Send your order documents to other programs or in e-mail. 

Batch label printing for received items 

Print labels for the exact quantities of items received in each shipment of goods. 

Support for Microsoft Dynamics GP and QuickBooks 2006 

Integrate Store Operations with these popular accounting packages. 

Additional device support 

The Ingenico 6550 payment terminal is now supported. 
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Where to find more information 

Online Help 
See online Help in Store Operations POS and Store Operations Manager for more 

information about Store Operations and complete step-by-step instructions. 

In many parts of Store Operations, Help is context sensitive, providing detailed 

explanations of the specific controls and options you see on the screen. 

To open Help in Store Operations POS 

 Press F1. 

To open Help in Store Operations Manager 

 On the Help menu, click Microsoft Store Operations Manager Help. 

Or 

 Press F1. 

Web 
For product information about Microsoft Dynamics RMS and other Microsoft retail 

software, please visit the Microsoft Dynamics Retail Management System (RMS) 

Web site at www.microsoft.com/msrms 

For information about other Microsoft Dynamics business and accounting 

software, visit the Microsoft Dynamics™ Web site at www.microsoft.com/dynamics 

Microsoft support services 
Get technical support for Microsoft Dynamics Retail Management System (RMS) at 

the product support Web site, www.microsoft.com/dynamics/support. For 

telephone support for U.S. customers, please call 888-477-7877. 

For the latest news about Microsoft Dynamics RMS, visit the Using Microsoft 

Dynamics Retail Management System Web site at 

http://www.microsoft.com/msrms/customer 
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Also, you can find additional product support information at the Microsoft Help 

and Support Web site at http://support.microsoft.com 

Maintenance plans 

Your Microsoft Dynamics RMS maintenance plan gives you access to Microsoft 

CustomerSource, product newsgroups, Knowledge Base articles, and other 

exclusive Internet offerings. For information about continuing support options, see 

http://www.microsoft.com/dynamics/support 

Microsoft CustomerSource 

CustomerSource is a Microsoft Web site that provides Microsoft customers 

around-the-clock access to support resources and a multitude of tools to improve 

their business processes and practices. Site access is available to Microsoft 

customers currently on a service plan at 

https://mbs.microsoft.com/customersource 

Microsoft Certified Partners 

You can also take advantage of an ongoing relationship with a Microsoft Certified 

Partner who understands the unique service needs of your business. To find a 

partner near you, visit the Microsoft Dynamics RMS Web site at 

http://www.microsoft.com/msrms 
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Introducing Store Operations 
You can set up Microsoft Dynamics Retail Management System Store Operations 

on one computer or on multiple computers. The arrangement you choose 

depends on how many computers you have in your store and how you intend to 

use them. 

The one-computer store 
If your store has only one computer, that computer will be used for both 

management and point-of-sale tasks. It will also have the store database—the file 

where Store Operations keeps your store’s information. 

The multiple-computer store 
In a multiple-computer store, you designate one computer as your main 

computer, which is often set up in a back office and used for management tasks. 

The other computers can be used as register computers for ringing up sales or for 

other purposes, such as processing mail-order sales. 

Note Your store’s network must be functioning properly for you to install and 

use Store Operations on multiple computers. 

` `

`

Main computer 

Register 1 Register 2

Network
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The computer that holds the store database is referred to as the database server. 

The main computer can – but is not required to – act as the database server. The 

other computers in your store will communicate with the main computer and the 

database server through your network. 

Note You can install Store Operations Manager on additional computers 

without additional licenses. However, you must purchase one license for 

each computer where you want to run Store Operations POS.  
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Installing Store Operations 

Before you install 
The following information will help you maximize the efficiency and stability of 

your Store Operations installation. Review these requirements and guidelines prior 

to installing Store Operations on your computer. 

 Install an edition of Microsoft SQL Server. SQL Server Express Edition 2005 

(SQL Server Express) with Service Pack 1 (SP1) is provided with your Store 

Operations software, or you can separately purchase the Standard or 

Enterprise Edition of SQL Server 2005 with SP1. Store Operations will also 

work with the Standard or Enterprise Edition of SQL Server 2000 with SP4, or 

with SQL Server 2000 Desktop Edition (MSDE 2000) with SP4. 

 For successful database communications, all machines must be using the same 

network protocols. The Microsoft Dynamics RMS installation program enables 

the TCP/IP and Named Pipes protocols by default. If your database server 

computer is using a protocol other than TCP/IP or Named Pipes, you will need 

to enable the protocols you want to use. To enable new protocols on any 

computer where Store Operations is installed, use Client Network Utility (on 

the Start menu, point to Microsoft Dynamics RMS, and then click Client 

Network Utility). For more information, click Help in the utility. 

To enable new protocols on the database computer if Microsoft Dynamics 

RMS is not installed there, use SQL Server Configuration Manager for SQL 

Server 2005 or Client Network Utility for SQL Server 2000. For more 

information, see "Configuring Client Network Protocols" in SQL Server 2005 

Books Online. 

 You must use Store Operations Administrator to create and configure your 

database before you can run Store Operations Manager or Store Operations 

POS. 

 For information on quickly setting up the Store Operations database, see 

―Setting up Store Operations.‖ 
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System requirements 

The following system requirements are needed to run Store Operations: 

 PC with a Pentium 600 MHz or higher processor (1 GHz recommend) 

 Microsoft Windows Vista, Windows XP Home or Professional Edition with 

Service Pack (SP) 2 or later, Windows Server 2003 with SP1 or later, Windows 

2000 with SP4 or later, or Windows Embedded for Point of Service 

 Minimum 192 megabytes (MB) of RAM (512 MB or higher recommended) 

 Approximately 50 MB of available hard disk space for the Store Operations 

application files (will vary depending on the configuration and location of 

database files) 

 A CD-ROM drive 

 VGA (1024x768) or higher resolution monitor 

 Microsoft SQL Server 2005 Express Edition (SQL Server Express) with SP1 or 

later [SQL Server Express with SP1 is included] 

-or- 

Microsoft SQL Server 2005 Standard or Enterprise Edition with SP1 or later 

[available separately] 

-or- 

Microsoft SQL Server 2000 Desktop Engine (MSDE 2000) with SP4 or later 

[available separately] 

-or- 

Microsoft SQL Server 2000 Standard or Enterprise Edition with SP4 or later 

[available separately] 

 Microsoft Mouse or compatible pointing device 

Additional items or services required to use certain features 

 Payment processing requires additional services and may require additional 

hardware 

 Touch screen monitor 

 OPOS-compatible hardware: receipt printers, cash drawer, MICR, MSR, pole 

display, weigh scale, signature capture device, scanner 
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 Internet access (may require payment of a separate fee to a service provider, 

and local and/or long distance telephone charges may apply) 

Activating Store Operations 

Activation reduces software piracy by authenticating your software as a genuine, 

fully licensed copy. You will need a separate copy of the software for each 

computer where you want to run Store Operations POS. When you first run Store 

Operations POS, you will be prompted to activate the software. 

Activation is not required on back-office computers where you only want to run 

Store Operations Administrator and Store Operations Manager. 

If you ever need to reinstall Store Operations on the same computer where it was 

installed previously, you will need to activate the software again. Usually, you can 

use the same product key you used before. 

If you have an Internet connection, you can quickly and easily activate Store 

Operations over the Internet. Otherwise, you can activate the software by 

telephone. 

1 Start Store Operations POS. 

The Activation Wizard starts. 

2 Follow the instructions in the Activation Wizard. 

Microsoft SQL Server 

Microsoft SQL Server is a client-server database management system. Solutions 

based on SQL Server are highly scalable, from a single processor laptop and a 

database maximum size of two gigabytes (2 GB) to a cluster of servers that can 

comfortably manipulate multi-terabyte databases and thousands of users. Unlike 

file-based databases, client-server database engines manage read-write 

operations to the database, enabling them to handle many more concurrent users 

and vastly greater amounts of data. Microsoft SQL Server is offered in different 

editions based on database size, number of users, and hardware requirements. 

SQL Server 2005 Express Edition (SQL Server Express) is a fully SQL Server-

compatible database engine that supports multiple concurrent users and can be 

used with databases of up to 4 GB in size. SQL Server Express is provided free of 

charge with Store Operations and will be installed during Store Operations 

installation unless an existing instance of another SQL Server product is present. 
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If you need to store more than 4 GB of data, you will need to purchase the 

Standard or Enterprise Edition of SQL Server 2005. 

Note Be sure to make a note of the user name and password you define when 

you set up SQL Server. 

Do not change your computer name after SQL Server has been installed on the 

machine. SQL Server uses the computer name internally; if you change the 

computer name, SQL Server detects a different name and generates an error 

message. If this happens, you will need to run SQL Server Setup again. 

SQL Server can operate in one of two security (authentication) modes: Windows 

authentication or SQL Server authentication. SQL Server authentication is much 

easier to manage than Windows authentication, which uses domain user and 

group accounts. For example, a single SQL Server user name and password can be 

created for all Store Operations computers, rather than creating all the necessary 

Windows domain user and group accounts. Also, Windows authentication is 

available only when all of your computers are part of a Windows domain. 

You will need to use SQL Server authentication with Microsoft Dynamics RMS. 

Note You can find information about SQL Server security updates at the 

Microsoft SQL Server Web site, www.microsoft.com/sql 

Installing Store Operations 
There are two steps to installing Store Operations. Each step is described in detail 

below. 

Step 1 Install, configure, and test POS hardware 

Step 2 Install Store Operations 

Note For information about how to uninstall Store Operations, see ―Uninstall 

Store Operations‖ in Store Operations Manager Help. 

Step 1  Install, configure, and test POS hardware 

Store Operations has incorporated OLE for Point of Sale (OPOS) standards, so you 

can easily use many OPOS-compatible POS hardware devices, minimizing 

software maintenance and upgrade costs. 
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You can connect one or more POS hardware devices to your computer; for 

example, a cash drawer, receipt printer, bar code scanner, check reader (MICR), 

PIN pad, line display, magnetic stripe reader (MSR), or signature capture device. 

Store Operations will work with Windows printers or OPOS-compatible printers. 

Some printers may not be able to utilize all Store Operations features (for 

example, label graphics).  

You should obtain the OPOS service objects from your hardware manufacturer 

and install them on each POS register. Make sure that you configure Store 

Operations accordingly. See ―Setting Up Store Operations‖ for more information. 

Recognizing that you may currently use older or specific POS devices that do not 

have OPOS service objects, we have included some OPOS service objects on your 

Store Operations CD.  

While you can add and remove POS hardware at any time, installing your devices 

before installing Store Operations can make the installation process go more 

smoothly. 

Note You can find a current list of compatible hardware (Hardware 

Compatibility List) at the Microsoft Retail Management System Web site 

at www.microsoft.com/msrms. 

A Microsoft Certified Partner can also provide POS hardware devices that 

the partner has determined to be compatible with Store Operations. 

You might find that other POS hardware devices work with Store 

Operations, but Microsoft recommends using devices that are known to 

be compatible. 

To install POS hardware devices 

1 Connect each POS hardware device and install the OPOS software according 

to the manufacturer’s instructions. 

Note Whether you connect the device first or install the software first varies 

by the device and manufacturer. 

Typically, the device’s manufacturer provides OPOS software and 

configuration software on a CD that accompanies the device. 
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Some POS hardware devices can be connected to a second device, which is 

then connected to the computer. For example, you can connect: 

 A cash drawer, line display, or MICR/printer to the computer or to a 

receipt printer. 

 An MSR (magnetic stripe reader) or PIN pad to the computer or to a 

signature capture device. 

Notes 

 If you use more than two or three of these secondary connections, 

some of your devices might not work properly. 

 Make sure you connect each device using the proper cable. 

 When connecting a device to the computer, make sure to use the 

appropriate port on the computer, according to the manufacturer’s 

instructions. 

2 Configure and test each device according to the manufacturer’s instructions 

before using it with Store Operations. 

Note For more information about connecting, installing, and configuring 

compatible POS hardware, contact your Microsoft Certified Partner. 

 Installing POS hardware correctly is essential if it is to work properly 

with Store Operations. 

Step 2  Install Store Operations 

To install Store Operations 

1 Insert the Store Operations CD in your computer’s CD drive. 

Note Install Store Operations on the local computer, not on a remote 

computer over a network. 

If the installation program doesn’t start automatically, use Windows Explorer 

to view the contents of the Store Operations CD, and then double-click 

Autorun.hta. 

2 Click Before you install and read the Readme document for the most up-to-

date information about installation, new features, documentation, bug fixes, 

and product support. 
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3 Click Install Store Operations and follow the instructions in the Installation 

Wizard. 

Note As Store Operations finishes installing, it will look for Microsoft SQL 

Server 2000 or MSDE 2000. If it finds an instance of either software, it 

will not install or reinstall MSDE 2000. 

Network installation 
For successful database communication, all machines must be using the same 

network protocols. The Microsoft Dynamics RMS installation program enables the 

TCP/IP and Named Pipes protocols by default. If your server uses a different 

protocol, use the Client Network Utility to enable the protocol you want to use. 

The Client Network Utility is available on the Start menu in the Microsoft 

Dynamics RMS program group. For more information, click the Help button in the 

utility. 

Note If you want to enable TCP/IP on your server instead and you are running 

SQL Server 2005, use the SQL Server Configuration Manager. For SQL 

Server 2000, the Client Network Utility is available in the Microsoft SQL 

Server program group on the Start menu. For more information, see 

"Configuring Client Network Protocols" in SQL Server 2005 Books Online. 

Windows Firewall 

Because of the security features in Windows XP Service Pack 2, if you install 

Microsoft Dynamics RMS on a computer that is remote from SQL Server, you must 

set up the Windows Firewall to allow your server to communicate with Microsoft 

Dynamics RMS. If you will be running Microsoft Dynamics RMS Headquarters in 

conjunction with Store Operations, you must also set up the Windows Firewall to 

allow communication between Headquarters Client and Headquarters Server. 

For detailed instructions for setting up the Windows Firewall for network 

installation, see Microsoft Knowledge Base article 884102, ―How to configure 

Retail Management System programs for use with Windows XP Service Pack 2,‖ 

available at http://support.microsoft.com.
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Setting up Store Operations 
Once you have installed Store Operations, you need to set up your store database. 

You can choose ―Express setup‖ or ―Complete setup.‖ If you choose "Express 

setup," you will restore a ready-made sample database that provides essential 

information for a fictitious store. You can use this sample database to practice 

Store Operations tasks and become familiar with the software. If you choose 

―Complete setup,‖ you will create a database from scratch and begin using Store 

Operations in your daily operations. 

Express setup 
Use the following four steps to quickly get the sample Store Operations database 

up and running. Each step is described in detail below. 

Step 1 Start Store Operations Administrator and connect to the database server 

Step 2 Create the sample database 

Step 3 Configure the sample database 

Step 4 Start Store Operations Manager or POS 

Note For a description of the contents of the sample database, see "Using the 

sample database" in "Complete setup" later in this book. 

Step 1  Start Store Operations Administrator and connect to 

the database server 

You need to connect to the database server before you can create your Store 

Operations database or use any of Store Operations Administrator's database and 

query commands. For a complete overview of the entire setup and configuration 

process, refer to the ―Complete setup‖ section. 

Note Your database server must be running before you can connect to it. For 

information about starting the server automatically, see "Microsoft SQL 

Server" in "Installing Store Operations" earlier in this book.  
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To start Store Operations Administrator and connect to the database 

server 

1 Click Start, point to Programs, point to Microsoft Dynamics RMS, and then 

click Store Operations Administrator. 

2 On the File menu, click Connect. 

3 In the Server box, enter or select the name of the server running SQL Server. 

If the current computer is the database server, you can enter (local) in this 

box. 

4 Under Connection Information, select Use SQL Server authentication, and 

then enter your SQL Server user name and password. 

5 Click OK. 

Step 2  Create the sample database 

Use the Create Database Wizard in Store Operations Administrator to create the 

sample database. This is done by restoring the backup of the database that is 

provided in your C:\Program Files\Microsoft Retail Management System\Store 

Operations\DBFiles directory. 

To create the sample database with the Create Database Wizard 

1 On the Database menu, click Create. 

2 On the Welcome page, click Next. 

3 On the Database Size page, type a name for the sample database, such as 

MySampleDb, and then click Next. 

4 On the Database Growth page, click Next. 

5 On the Populate Database page, click the Browse  button, and then 

double-click the DBFiles folder. 

6 Select the Rmssample.bck file, click Open, and then click Next. 

7 On the final wizard page, click Finish, and then click OK in both completion 

messages. 



16 Getting Started Guide 

 

Step 3  Configure the sample database 

Once the sample database is created, you can configure it with the settings that 

allow Store Operations Manager and POS to connect to the database. 

To configure the sample database 

1 On the File menu, click Configuration. 

2 In the Server name box, type the name of the server where the sample 

database is stored. If you are running SQL Server and Store Operations on the 

same computer, you can use the default (local) as your server name. 

3 In the User name and Password boxes, type your SQL Server logon 

credentials. 

4 In the Database box, type the name of the database you just created. 

5 To make sure that Store Operations will successfully connect to your new 

database, click Test Database Connection. When Store Operations notifies 

you that the database was successfully connected, click OK. 

6 To save the configuration settings, click OK. 

Step 4  Start Store Operations Manager or POS 

When you create a database, a default account is automatically set up to allow 

you to log on and perform the initial setup. This account's user ID is "1" and its 

password is "password". Use this account ID and password to log on. 

Note To ensure database security, Microsoft recommends that you change the 

password for this account once you have logged on. 
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To start Store Operations Manager or POS 

1 Click Start, point to Programs, point to Microsoft Dynamics RMS, and then 

click Store Operations Manager or Store Operations POS. 

2 In the User ID box, enter "1". 

3 In the Password box, enter "password". 

4 Click OK. 

Note Use the Help files that accompany Store Operations Manager and POS to 

assist you in using Store Operations. To access online Help, either click 

Contents from the Help menu in Store Operations Administrator or press 

F1 in Store Operations POS. 

Complete setup 
There are five main steps to setting up Store Operations. 

Step 1 Connect to the database server 

Step 2 Create the store database 

Step 3 Configure the store database for each register 

Step 4 Set up appropriate EDC software 

Step 5 Set up hardware devices connected to registers 

Step 1  Connect to the database server 

You need to connect to the database server before you can create your Store 

Operations database or use any of the database and query commands in Store 

Operations Administrator. 
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To connect to the database server 

1 Make sure the database server is running, and then, on the File menu in Store 

Operations Administrator, click Connect. 

2 In the Server box, type or select the name of the server where your Store 

Operations database is located. If the database is on the current computer, 

you can enter (local) in this box. 

3 Under Connection Information, select Use SQL Server authentication., and 

then enter your SQL Server user name and password. 

4 Click OK. 

Note After your database is created, you can also connect to your database in 

the Connect to Server dialog box. This is done by selecting your database 

in the Database box. Note that you can only access the list of databases 

after you've entered your user name and password. 

Step 2  Create the store database 

Store Operations databases are created by restoring from backup files included 

with your software. You can choose to restore either the sample database or a 

blank database. The sample database contains information for a fictitious store. It 

can be used for practice or cashier training, or you can modify it for use as your 

store database. With a blank database, you must enter information from scratch. 

Using the sample database 

With the sample database, you can practice using Store Operations without 

affecting your actual store data. You can also use it later when training cashiers. In 

it, you will find inventory and sales data for a store named Tailspin Toys. This 

database includes: 

 Store-wide parameters 

 Security level structure 

 Detailed property information for the different types of items (standard, 

matrix, assembly, kit, lot matrix, and so on) 

 Department and category structure 
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 Item and sales tax structure 

 Cashiers, sales reps, suppliers, and customers 

 Tender types and currencies 

 Detailed information for registers, line display messages, net display channels, 

custom POS buttons, and receipt formats 

 Open, closed, and partial purchase orders and inventory transfers 

 Receipts, journals, and reports 

If you want to use some of the information and settings in the sample database, 

you can modify the sample database and make it your own. Use Store Operations 

Manager to add, delete, or change information to make the database relevant to 

your business. Once you are satisfied with your database changes, you can quickly 

prepare the database to go live by using the Delete Transactions command in 

Store Operations Administrator to delete all of the practice sales transactions, 

purchase orders, inventory transfers, and customer purchase history. 

For step-by-step instructions for creating the sample database, see "Express setup" 

earlier in this book. 

Creating the database from scratch 

A blank database contains only the basic structure of the Store Operations 

database. You will need to use Store Operations Manager to enter your inventory 

items, departments, categories, employees, and other information. 

To create a blank store database 

1 On the File menu in Store Operations Administrator, click Connect. Specify 

your server and user names and password, and then click OK. If you cannot 

connect, make sure that your database server is running. 

2 On the Database menu, click Create. 

3 On the Welcome page, click Next. 

4 On the Database Size page, type a name for your database, enter an initial 

size for the database, and then click Next. 

5 On the Database Growth page, specify how the database file should grow, 

and then click Next. In most cases, you can accept the defaults. 
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6 On the Populate Database page, click the Browse  button to locate the 

backup file of the blank database. 

Note This database is stored in the DBFiles folder on the CD-ROM or in 

your installation directory. 

7 Select the rmsdb.bck file, click Open, and then click Next. 

8 On the final wizard page, click Finish, and then click OK in both completion 

messages. 

Step 3  Configure the store database for each register 

After you have created your database, you can use the Configuration command to 

set up each point-of-sale register in your store with the proper database 

information. This enables communication between your registers and the store 

database. 

1  On the File menu in Store Operations Administrator, click Configuration. 

2 In the Server name box, type the name of the server where your store 

database is located. If the database is on the current computer, you can type 

(local) in this box.. 

3 In User name and Password boxes, type your SQL Server logon credentials. 

4 In the Database box, type the name of your store database. 

5 To make sure that Store Operations will successfully connect to the specified 

database, click the Test Database Connection button. When Store 

Operations notifies you that the database was successfully connected, click 

OK. 

6 Use the tabs to enter any register-specific information, and then click OK to 

save your settings. 

7 Repeat this procedure on any other registers in your store. 
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Step 4  Set up appropriate EDC software 

Store Operations interfaces with electronic draft capture (EDC) software to process 

credit and debit card transactions. Store Operations creates a request file that the 

EDC verification software then picks up to process its information. The payment 

processor tells Store Operations if the transaction was approved or not. 

Credit card transactions can be processed in Store Operations using one of these 

programs: 

 Preferred acquirer credit/debit card processing software 

 ICVerify for Windows (up to and including version 2.5) 

 PC-Charge (up to and including version 5.1) 

 Atomic Authorizer 

 WinTI/European EFT 

For debit card transactions, use your acquiring bank's credit/debit card processing 

EDC software. 

Setting up EDC software to work with Store Operations is complex. Many parties 

must be coordinated before you can properly process credit and debit card 

transactions. Microsoft suggests having a Microsoft Certified Partner assist you in 

setting up and configuring payment processing. For detailed instructions on 

setting up specific EDC software, refer to Store Operations Administrator Online 

Help. 
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Step 5  Set up hardware devices connected to registers 

After configuring and testing each of your hardware devices, you need to set up 

each device on the register on which it will be used.  

Note The following procedure describes configuring a scale; the steps for 

setting up other peripherals will be similar. 

To set up a hardware device 

1 Open Store Operations Manager and log on. If you haven't yet set up your 

own user accounts, you can enter "1" in the User ID box and "password" in 

the Password box. 

2 On the Database menu, point to Registers, and then click Register List. 

3 Select the applicable register, and then click Properties. 

4 Click the applicable peripheral tab (for example, Scale tab). 

5 Select the option that enables the device (for example, Scale is enabled for 

this register). 

6 In the OPOS device name field, enter the name of the device (for example, 

"Berkel Scale 1"). 

Note The name you enter here should match the one you entered in the 

OPOS Device Name field in the OPOS Service Settings dialog box 

when you configured your service object. 

7 Click OK to save the information. 
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Using Store Operations Manager 
and POS 

Using Store Operations for the first time 
For information about activating Store Operations, see ―Activating Store 

Operations.‖ 

Starting and exiting Store Operations Manager 

To start Store Operations Manager 

1 Click Start, point to Programs, point to Microsoft Dynamics RMS, and then 

click Store Operations Manager. 

2 Type the user ID and password provided to you by your Store Operations 

administrator. The user ID will be used by the system to validate the password 

and to determine your rights for accessing the data stored in the database. To 

run the Manager program, you must log in with a user account that has been 

granted manager rights. 

Note When a Store Operations database is created, a default user account is 

automatically set up to allow you to log on and perform initial database 

setup. The user ID for this account is "1" and its password is "password". 

After you set up your database, change the password for this account. 

To exit Store Operations Manager 

 On the File menu, click Exit. 
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Starting and exiting Store Operations POS 

To start Store Operations POS 

1 On the Windows Start menu, point to Programs, point to Microsoft 

Dynamics RMS, and then click Store Operations POS. 

2 Type the user ID and password provided to you by your Store Operations 

administrator. The user ID will be used by the system to validate the password 

and to determine your rights for accessing the data stored in the database. 

Note Store Operations creates a default user account with the ID number "1" 

and password "password". Use this combination to initially log on to Store 

Operations POS. 

To exit Store Operations POS 

1 Tender or cancel the current transaction (if any). 

2 Press Esc, and then click Yes to confirm that you want to close Store 

Operations POS. 

Note Only cashiers who have the privilege to exit Store Operations POS will be 

able to complete this procedure.
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Appendix A – Glossary 

bar code 

A code that can be read by a scanning device, usually composed of vertical bars of 

varying width and spacing. The bars that make up the bar code represent a series 

of numbers. 

cash drawer 

A cash drawer is connected to the register computer or printer by a cable. The 

drawer opens automatically at the end of a transaction. 

category 

A category is a group of inventory items within a department. For example, if a 

music store has departments like Jazz, Country, Classical, and so on, the Jazz 

department might have categories for artists, such as Miles Davis, Ray Charles, 

Wynton Marsalis, and so on. 

code 

Most of the information you create and manage in Store Operations is assigned 

codes. For instance, you will set up codes for each of your departments. These 

lookup codes must be unique numbers or abbreviations that will help you identify 

similar information. 

database 

Your database is the behind-the-scenes file that Store Operations uses to store, 

group, and manage your store information. Store Operations does all your 

database administration for you. You rarely need to work with the database 

directly. 

department 

A department is a group of inventory items within a store. For example, a sporting 

goods store might have departments for soccer, tennis, and so on. 
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employee 

Employees include any person who will be using Store Operations. For this reason, 

store owners, store managers, and associates are all considered employees. 

hardware device 

In this book, a hardware device is a peripheral device attached to a register for a 

specific retail task. Hardware devices can include cash drawers, receipt printers, 

bar code scanners, check readers (MICR devices), PIN pads, line display devices, 

magnetic stripe readers (MSRs), or signature capture devices. 

item 

An item is a product or service that you sell in your store. 

line display device 

A line display device is a hardware device connected to the register that displays 

messages to customers. You can specify these messages in Store Operations 

Manager. Also known as pole display device. 

magnetic stripe reader (MSR) 

This POS hardware device reads the magnetic stripe on the back of a credit or 

debit card. 

main computer 

In a multiple-computer store, main computer refers to the computer where you 

first installed Store Operations. This computer often holds your database and store 

information. If so, it can also be referred to as the database server. 

The main computer might be set up in a back office — out of sight of customers 

— rather than being operated as a register. It can then be used for managerial 

tasks such as ordering and receiving. 

In a store that has only one computer, that computer is the main computer. 

See also register 
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MICR device 

Commonly called a check reader, this device is connected to the register and reads 

the account number and other information on checks. MICR stands for magnetic 

ink character recognition. 

OPOS 

OPOS is a software standard for POS hardware devices. OPOS stands for OLE 

(Object Linking and Embedding) for Point of Sale. 

PIN pad 

A PIN pad is a POS hardware device for entering personal identification numbers 

(PIN) for debit cards. 

receipt printer 

A printer designed for printing receipts, typically using 4-inch roll paper and 

printing in 40 column format. 

register 

Because both Store Operations components are installed when Store Operations is 

installed, any computer where Store Operations is installed can be considered a 

register.  

In this book, register is typically used to differentiate point-of-sale computers from 

the back-office computer. These computers can also be referred to as ―clients.‖ 

See also main computer 

scanner 

A device connected to the computer that scans and reads bar codes. 

signature capture device 

An electronic pad that credit card customers sign with a stylus in lieu of signing a 

paper receipt. 
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supplier 

Suppliers are the companies and organizations that supply your inventory. 

tender type 

Tender types are the forms of payment that are accepted in your store, such as 

cash, check, MasterCard, and VISA. 
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Appendix B - Accessibility 
products and services 
Microsoft is committed to making its products and services easier for everyone to 

use. The following topics provide information about the features, products, and 

services that make Microsoft® Windows® more accessible for people with 

disabilities: 

 Accessibility features of Windows 

 Documentation in alternative formats 

 Customer service for people with hearing impairments 

 For more information 

Note The information in this section may apply only to users who license 

Microsoft products in the United States. If you obtained this product 

outside of the United States, you can use the subsidiary information card 

that came with your software package or visit the Microsoft Accessibility 

Web site at www.microsoft.com/enable for a list of Microsoft support 

services telephone numbers and addresses. You can contact your 

subsidiary to find out whether the type of products and services described 

in this section are available in your area. Information about accessibility is 

available in other languages, including Japanese and French. 

Accessibility features of Windows 

The Windows operating system has many built-in accessibility features that are 

useful for individuals who have difficulty typing or using a mouse, are blind or 

have low vision, or who are deaf or hard-of-hearing. The features are installed 

during Setup. For more information about these features, see Help in Windows 

and the Microsoft Accessibility Web site at www.microsoft.com/enable. 

Free step-by-step tutorials 

Microsoft offers a series of step-by-step tutorials that provide detailed procedures 

for adjusting the accessibility options and settings on your computer. This 

information is presented in a side-by-side format so that you can learn how to use 

the mouse, the keyboard, or a combination of both.  
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To find step-by-step tutorials for Microsoft products, visit the Microsoft 

Accessibility Web site at www.microsoft.com/enable. 

Assistive technology products for Windows 

A wide variety of assistive technology products are available to make computers 

easier to use for people with disabilities. You can search a catalog of assistive 

technology products that run on Windows at the Microsoft Accessibility Web site 

at www.microsoft.com/enable. 

If you use assistive technology, be sure to contact your assistive technology 

vendor before you upgrade your software or hardware to check for possible 

compatibility issues. 

Documentation in alternative formats 

If you have difficulty reading or handling printed materials, you can obtain the 

documentation for many Microsoft products in more accessible formats. You can 

view an index of accessible product documentation on the Microsoft Accessibility 

Web site at www.microsoft.com/enable. 

In addition, you can obtain additional Microsoft publications from Recording for 

the Blind & Dyslexic, Inc. (RFB&D). RFB&D distributes these documents to 

registered, eligible members of their distribution service. For information about 

the availability of Microsoft product documentation and books from Microsoft 

Press, contact:  

Recording for the Blind & Dyslexic, Inc. 

20 Roszel Road 

Princeton, NJ 08540 

Telephone number in the United States: (800) 221-4792 

Telephone number outside the United States and Canada: (609) 452-0606 

Fax: (609) 987-8116 

Visit the Recording for the Blind & Dyslexic Web site at www.rfbd.org. 

Note that Web addresses can change, so you might be unable to connect to the 

web sites mentioned here. 
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Customer service for people with hearing impairments 

If you are deaf or hard-of-hearing, complete access to Microsoft product and 

customer services is available through a text telephone (TTY/TDD) service: 

 For customer service, contact Microsoft Sales Information Center at (800) 892-

5234 between 6:30 A.M. and 5:30 P.M. Pacific Time, Monday through Friday, 

excluding holidays.  

 For technical assistance in the United States, contact Microsoft Product 

Support Services at (800) 892-5234 between 6:00 A.M. and 6:00 P.M. Pacific 

Time, Monday through Friday, excluding holidays. In Canada, dial (905) 568-

9641 between 8:00 A.M. and 8:00 P.M. Eastern Time, Monday through Friday, 

excluding holidays. 

Microsoft Support Services are subject to the prices, terms, and conditions in place 

at the time the service is used. 

For more information 

For more information about how accessible technology for computers helps to 

improve the lives of people with disabilities, see the Microsoft Accessibility Web 

site at www.microsoft.com/enable. 
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